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Foreword

Proprietary Notice and Disclaimer

The information herein disclosed is the property of iCRco., Inc. Information in this docu-
ment is subject to change without notice and does not represent a commitment by iCRco to
incorporate changes or improvements in units previously sold or shipped.

No part of this document may be reproduced or transmitted in any form, electronic
or mechanical, including photocopying and recording, for any purpose other than the
purchaser’s own use without the express written permission of iCRco.

Copyright

Copyright c© iCRco Inc. 2003 - 2010
All rights reserved.

Trademarks

iCR 2600 R©, iCR 1000 R©, iCR 1000 Dual R©, iCR 2600 R©, iCR 2600 Dual R©, iCR 2600SF R©, iCR
Vet R©, iCR CR Vet Dual R©, iCR Mobile R©, iCR 1-D R©, iCR Chiro R©, iCR Chiro Dual R©, iCR
3600 R©, iCR 3600SF R©, iCR VERTX R©,iDR R©,www.icrcompany.com and QPC XSCAN32 are
the trademarks of iCRco. All other trademarks are the property of their respective owners,
and are hereby acknowledged.

Terms

Any one of the following iCR products will be referred to as the “CR unit” throughout
this document: iCR 1000 R©, iCR 1000 Dual R©, iCR 2600 R©, iCR 2600 Dual R©, iCR 2600SF R©,
iCR 3600 R©, iCR Vet R©, iCR Vet Dual R©, iCR Mobile R©, iCR 1-D R©, iCR Chiro R©, iCR Chiro
Dual R© iCR VERTX R© Any one of the following iCR products will be referred to as “iCR
dual unit” throughout this document: iCR 1000 Dual R©, iCR 2600 Dual R©, iCR Vet Dual R©,
iCR Chiro Dual R©Any one of the following iCR products will be referred to as “iCR desktop
unit” throughout this document: iCR VERTX R©. The iDR R©will be referred to as the “DR
unit” throughout this document.
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Contact Information

iCRco., Inc. USA
Address: 2580 West 237th Street, Torrance, CA, 90505
Phone: +1.310.921.9559
Fax: +1.310.542.7236
Email: info@icrcompany.com
Web: http://www.icrcompany.com

iCRco., Inc. Europe
Address: 31a Ridlerstrasse, 80339 Munich, Germany
Phone: +49.89.2555.757.150
Email: info@icrcompany.com
Web: http://www.icrcompany.com

iCR 3600 M Information

Please Enter the details of the iCR 3600 M system here:

Serial Number:

Date Purchased:

Interface Type: USB 2.0
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Safety Information

Be sure to read and understand the installation and operating instructions before applying
power to the CR unit.

C A U T I O N

C A U T I O N

D A N G E R

CAUTION:  FOR CONTINUED 
PROTECTION AGAINST RISK OF FIRE, 
REPLACE ONLY WITH SAME TYPE AND 
RATING OF FUSE.

CAUTION:  TO REDUCE THE RISK OF 
ELECTRONIC SHOCK, DO NOT REMOVE 
COVER.  NO USER SERVICEABLE PARTS 
INSIDE.  REFER SERVICING TO QUALIFIED 
SERVICE PERSONNEL.

Invisible laser 
radiation when open.

AVOID EXPOSURE
TO BEAM.

Class 3b laser product.
(IEC 825-1)

3A SLOW BLOW, 250VFUSE

INPUT: 100-240VAC        3A 50-60Hz

Conventions

! DANGER A DANGER indicates that personal injury may occur if the Service person
does not perform the procedure correctly.
! WARNING A WARNING indicates that a user must be constantly aware of something

that may prove hazardous.
! CAUTION A CAUTION indicates that damage to the product or user may occur if the

user does not perform the procedure correctly.
Note A NOTE indicates important information that helps you make better use of your CR

and Software.
Notice A NOTICE indicates either potential damage to hardware or loss of data and tells

you how to avoid the problem.

Laser Safety

! CAUTION This equipment employs a laser. Laser radiation may be present if the CR
system is operated without the covers. Avoid the laser beam. Direct exposure to laser light
must be avoided.

The CR unit incorporates a Red ≥ 80mw high-power solid-state laser diode. The CR covers
protect the service person from direct exposure to laser light. These covers will protect
a user/service person only if they are properly installed. Covers must be removed and
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replaced by properly trained service personnel. Contact iCRco if there are any issues with
the covers being damaged or replacement covers are needed.

Electrical Hazards

! WARNING This equipment is operated with hazardous voltages which can shock, burn,
or cause death.

Notice The CR unit must be connected to a uninterruptible power supply (UPS). Failure
to use a (UPS) will void the warranty.

The equipment must be serviced by properly trained technicians certified by iCRco, Inc.
Do not connect the CR unit with a damaged or sub-standard power cable. Do not use an
extension cord with this device. The CR unit should be properly grounded and power con-
nections inspected to ensure safe operation. Use at least a 1300VA (780W) uninterruptible
power supply (UPS) with this device, as it is sensitive to variations in power.

FCC Notification

This equipment generates, uses, and can radiate radio frequency energy, and if not installed
properly, can cause interference with radio communications.
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Guidance and Manufacture’s declaration – Electromagnetic Emis-
sions & Immunity

Table 1: Electromagnetic Emissions
Guidance and manufactures’ declaration – electromagnetic emissions
The iCR 3600 M is intended for use in the electromagnetic environment specified
below. The customer or the user of the iCR 3600 M should assure that it is used
in such an environment.
Emissions test Compliance Electromagnetic environment – guidance
RF emissions
CISPR 11

Group 1 The iCR 3600 M uses RF energy only for its
internal function. Therefore, its RF emissions are
very low and are not likely to cause any
interference in nearby electronic equipment.

RF emissions
CISPR 11

Class B The iCR 3600 M is suitable for use in all
establishments, including domestic and those
directly to the public low voltage pwoer supply
network that supplies buildings used for
domestic purposes.

Harmonic
emissions IEC
61000-3-2

Class B

Voltage fluctu-
ations/flicker
emissions IEC
61000-3-3

Complies

Table 2: Electromagnetic Immunity

Immunity
Test

IEC 60601 Test
Level

Compliance
Level

Electromagnetic Environment –
Guidance

Electrostatic
discharge
(ESD) IEC
61000-4-2

±(2, 4, 6) kV
Contact

±(2, 4, 8) kV
air

±(2, 4, 6) kV
Contact

±(2, 4, 8) kV
air

Floors should be wood, concrete
or ceramic tile. If floors are
covered with synthetic material,
the relative humidity should be at
least 30%.

Electrical
fast tran-
sient/burst
IEC
61000-4-4

±2 kV for
power supply
lines

±1kV for
input/output
lines

±2 kV for
power supply
lines

±1kV for
input/output
lines

Mains power quality should be
that of a typical commercial or
hospital environment.

continued on next page. . .
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Table 2 continued. . .
Immunity
Test

IEC 60601 Test
Level

Compliance
Level

Electromagnetic Environment –
Guidance

Surge IEC
61000-4-5

±1 kV
differential
mode

±2 kV
common mode

±1 kV
differential
mode

±2 kV
common mode

Mains power quality should be
that of a typical commercial or
hospital environment.

Voltage
dips, short
interrup-
tions and
voltage
variations
on power
supply
input lines
IEC
61000-4-11

<5% UT

(>95% dip in
UT ) for 0.5
cycle.

40% UT (60%
dip in UT ) for
5 cycles.

70% UT (30%
dip in UT ) for
25 cycles.

<5% UT

(>95% dip in
UT ) for 5 sec.

<5% UT

(>95% dip in
UT ) for 0.5
cycle.

40% UT (60%
dip in UT ) for
5 cycles.

70% UT (30%
dip in UT ) for
25 cycles.

<5% UT

(>95% dip in
UT ) for 5 sec.

Mains power quality should be
that of a typical commercial or
hospital environment. If the user
of the iCR 3600 M requires
continued operation during
power mains interruptions, it is
recommended that the iCR 3600
M be powered from an
uninterruptible pwoer supply or a
battery.

Power
frequency
(50/60Hz)
magnetic
field IEC
61000-4-8

3A/m 3A/m Power frequency magnetic fields
should be at levels characteristic
of a typical location in a typical
commercial or hospital
environment.

NOTE: UT is the a.c. mains voltage prior to application of the test level.
continued on next page. . .
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Table 2 continued. . .
Immunity
Test

IEC 60601 Test
Level

Compliance
Level

Electromagnetic Environment –
Guidance

Conducted
RF IEC
61000-4-6

Radiated
RF IEC
61000-4-3

3Vrms 150 kHz
to 80 MHz

3 V/m 80 MHz
to 2.5 GHz

3Vrms

3 V/m

Portable and mobile RF
communications equipment
should be used no closer to any
part of the iCR 3600 M, including
cables, than the recommended
separation distance calculated
from the equation applicable to
the frequency of the transmitter.

Recommended separations
distance
d = 1.2

√
P

d = 1.2
√
P 80 MHz to 800 MHz

d = 2.3
√
P 800 MHz to 2.5 GHz

where P is the maximum output
power rating of the transmitter in
watts (W) according to the
transmitter manufacturer and d is
the recommended separation
distance in meters (m).

Field strengths from fixed RF
transmitters as determined by an
electromagnetic site surveya,
should be less than the
compliance level in each
frequency rangeb.

Interference may occur in the
vicinity of equipment marked
with the following symbol:

NOTE 1: At 80 MHz and 800 MHz, the higher frequency range applies.
NOTE 2: These guidelines may not apply in all situations. Electromagnetic
propagation is affected by absorption and reflections from structures, objects
and people.
continued on next page. . .
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Table 2 continued. . .
Immunity
Test

IEC 60601 Test
Level

Compliance
Level

Electromagnetic Environment –
Guidance

a Field strengths from fixed transmitters, such as base stations for radio
(cellular/cordless) telephones and land mobile radios, amateur radio, AM
and FM radio broadcast and TV broadcast cannot be predicted theoretically
with accuracy. To assess the electromagnetic environment due to fixed
RF transmitters, an electromagnetic site survey should be considered. If
the measured field strength in the location where the iCR 3600 M is used
exceeds the applicable RF compliance levels above, the iCR 3600 M should be
observed to verify normal operation. If abnormal performance is observed,
additional measures may be necessary, such as reorienting or relocating the
iCR 3600 M.
b Over the frequency range 150 kHz to 80 MHz, field strengths should be
less than 3 V/m.

iCRco Warranty

iCRco, Inc. (“iCRco”) values your business and always strives to provide high quality
products and services. All iCRco products are provided with an initial warranty so the
hardware and software are covered from the date of purchase. This limited warranty
solely applies to new products manufactured by or for iCRco and originally purchased
from iCRco or an authorized dealer of iCRco products for your own use. In addition, an
extended warranty is available for most new and recently purchased iCRco products for an
additional charge.

Hardware Limited Warranty

iCRco warrants its hardware products to be free of defects in materials and workmanship
for a period of one (1) year from the date of original shipment from iCRco subject to the
limitations set forth herein. If a product proves to be defective in material or workmanship
during the warranty period, iCRco will, at its sole option, repair or replace the product
with a similar product. Repaired and replacement products may be or include refurbished
or remanufactured parts. Any replacement item assumes the remaining warranty period of
the original product. iCRco provides no warranty for any third party hardware or software
included with any product or later acquired.

Software Limited Warranty/Support

iCRco warrants that its QPC XSCAN32, Captera, and/or ClarityPACS software originally
provided with any product will substantially conform to iCRco’s specifications and that
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the media, not including hard drives, on which the software is furnished will be free from
defects in materials and workmanship under normal use for a period of one (1) year from
the date of original shipment from iCRco. iCRco’s sole obligation under this warranty is
limited to making reasonable efforts to ensure such conformity and to supply the consumer
with a corrected version of the software as soon as it is practical after the consumer has
notified iCRco of any non conformity. iCRco does not warrant that the operation of any
software will be uninterrupted, glitch or error free or that functions contained in the
software will operate in the combinations which may be selected for use by the user or
meet the user’s requirements. This limited software warranty will be void if the software is
modified without the written approval of iCRco or is used outside of the recommended
parameters or equipment. iCRco does not provide any warranty or support for any other
software.

iCRco agrees to provide one (1) year of telephonic and/or e-mail based support for QPC
XSCAN32, Captera, and/or ClarityPACS software originally provided with any new iCRco
product from the date of original shipment from iCRco. All software support shall be
limited to making reasonable efforts to resolve iCRco software issues and shall be limited
to iCRco’s regular business hours. In addition, iCRco will provide revisions and upgrades
to its software upon request (when available) during the first year after the software was
originally shipped from the iCRco factory. The initial support period will include support
via remote login software (GoToMeeting), only if the customer has access to the Internet
from that PC and only if the customer agrees iCRco shall have no liability in connection
with its support efforts. Remote login software allows iCRco technical support to remotely
access the customer’s PC via the Internet for the purposes of rendering technical support.
Please note that this warranty, including software support, does not include computer
hardware, third party software or operating system or network issues, which are outside
the control of iCRco.

Warranty Product Technical Requirements

iCRco requires that all DR, CR, Scanner and/or products requiring PCs be fitted and
installed with a 1500VA (1500W) uninterruptible power supply (“UPS”). iCRco recommends
the APC 1000 specification UPS or equivalent. For warranty evaluation and service, iCRco
requires the customer to provide an Internet connection (DSL or Dial-up) or the minimum
of a phone line accessible by an extension cord to the product enabling iCRco technicians to
perform remote diagnostics on installed equipment. In addition, each iCRco product must
be installed, maintained and operated in accordance with the respective product manual.
Failure to comply with these requirements will result in a voided warranty claim.

Requesting Warranty Service

For information on obtaining warranty service, call iCRco’s customer support at (310)921-
9559. In order to evaluate a warranty service request, iCRco requires the following infor-
mation: the iCRco serial number of the product, a detailed description of the problem,
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customer name and contact information; product location and operating conditions; a copy
of the purchase documents, and sufficient information and authorization, including a liabil-
ity release as to any loss of data (that should always be backed up), software or network
injury, or downtime, allowing iCRco technicians remote access to the product. Product may
not be returned to iCRco without first obtaining a Return Material Authorization (“RMA”)
number from iCRco. Prior to providing an RMA, iCRco may require remote access to the
product. If iCRco determines that the product may be defective, is under warranty and
necessitates a return to iCRco for service, an RMA number and instructions for return of
the product will be given. iCRco is not responsible for any unauthorized returned product,
i.e. one for which an RMA number has not been issued by iCRco.

Warranty service requires all authorized returns be shipped to the iCRco factory prepaid
and insured. All such authorized returns are the customer’s responsibility. For products
sold and located within the United States, iCRco will pay for return shipping.

Products being returned are only to be shipped in iCRco approved shipping containers.
The original box and packaging materials are approved and should be kept for moving
and/or shipping the product. Approved packaging my also be purchased from iCRco for
an additional charge. iCRco shall have no liability nor responsibility for warranty service
to any product that is not shipped in an iCRco approved shipping container or that is
damaged from incorrect packaging or damaged during shipping.

Additional Warranty Limitations and Extent of Warranty

This warranty does not apply if the product has been damaged by accident, misuse or
abuse. In addition, warranty service does not include the repair of failures or defects caused
by: unauthorized attachments to any iCRco product, unsuitable physical or operating
environment, maintenance or repair by anyone other than iCRco or the iCRco authorized
dealer that sold the product, operation of a product beyond its duty cycle, use of the
product outside of its specifications, the use of supplies, parts, materials, software, or
interfaces not furnished, authorized or recommended by iCRco. If the product, including
any software has been opened, tampered with, modified or altered in any way without
written authorization by iCRco, the warranty will no longer apply.

This warranty applies only to products manufactured by, or for, iCRco, and that can be
identified by an “iCRco” serial number as originally affixed to the product. Any modifica-
tion to the iCRco serial number tag or its attachment to the product shall immediately void
the warranty.

This warranty is non-transferable and subsequent owners must contact iCRco to establish
if the equipment is eligible for an extended warranty.

THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO ANY iCRco
PRODUCT OTHER THAN AS SPECIFICALLY SET FORTH HEREIN, AND iCRco SPECIF-
ICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANT
ABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND SATISFACTORY QUALITY.
ANY WARRANTIES THAT MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW
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ARE LIMITED IN DURATION TO THE INITIAL WARRANTY PERIOD AND NO WAR-
RANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMA-
TION, SPECIFICATIONS, PRICES, AND SERVICES ARE SUBJECT TO CHANGE AT ANY
TIME WITHOUT NOTICE.

Limitation of Remedies and Liability/Exclusion of Damages

The exclusive remedy for any defective product is limited to the repair or replacement of
the defective product. iCRco shall have a reasonable time after determining that a defective
product exists to repair or replace a defective product. iCRco’s entire liability for any
product is limited to the actual purchase price for the product. This limitation applies even
if iCRco cannot or does not repair or replace any defective product.

IN NO EVENT WILL iCRco BE LIABLE FOR ANY GENERAL, SPECIAL, CONSEQUEN-
TIAL OR INCIDENTAL DAMAGES, including but not limited to, damages related to
the loss of use, loss of recorded product, the installation of replacement product, or any
inspection, testing, or redesign caused by any defect or by the repair or replacement of
any product arising from a defect in any product. This exclusion of damages applies even
if the customer advises iCRco or an iCRco dealer of the possiblity of such damages. This
limitation of remedies also applies to claims against any suppliers or dealers of iCRco. iCRco and its
suppliers’ and dealers’ limitations of remedies are not cumulative. Such suppliers and dealers are
intended beneficiaries of this limitation. iCRco is not liable for any claim by or against the customer
arising from a third party claim.

Revision History

Revision Author Date Notes
A MS 2008-05-22 Initial Release
B MS 2010-01-27 Revised for new computer bracket
C MS 2010-03-22 Updated safety information
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1. Introduction

1.1 Overview

The CR unit is an ultra high resolution Computed Radiography device. It is designed to
scan cassettes containing phosphor screens (CR plates) using patented technology. CR
plates are transported past a scanning head without bending or using rollers. This flat scan
path results in ultra high resolution images with high fidelity across the entire image. High
resolution is achieved from the CR plates by coupling the flat scan path with a high energy
laser.

The CR unit collects 16 Bit data that is converted to a DICOM 3.0 image and can be
stored, viewed, manipulated, and sent to any other storage device, printer, or viewing
station through DICOM. This document contains a basic technical overview of the CR unit
including the optical systems, electronic components, and driving software subsystems.
A general description of the systems functionality and user interfaces will be described.
Unpacking of the hardware is covered, as is software installation, and troubleshooting
are also included. This document is intended for users or service people who need to
understand the basic underlying principles of operation for the CR unit.
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2. Pre-Installation

2.1 Voltage Requirements

The iCR 3600 Mincorporates an international switching power supply. iCRco employs CE
certified medical grade universal power supplies to allow the unit to work between 90
to 253V AC 50/60Hz. In order to run the iCR 3600 Mwith different power types, apply
voltage to the power input module at the end of the iCR 3600 M. For international units,
a local power cord must be used that can handle the power requirements of the unit. A
13A/125V power cord is sufficient.

2.2 Environmental

The iCR 3600 M should not be placed in a room with a film processor present. This will
void the warranty. The humidity and temperature limits are 20 to 80% non-condensing,
and 50 to 95◦F (10 to 35◦C) operating, respectively.

Installation of the iCR 3600 M near high magnetic fields may cause the iCR 3600 M to
malfunction. The iCR 3600 M should not be placed in a room with an MRI, CT, or any other
equipment that produces high magnetic fields.

The room should have good ventilation. Another factor to consider prior to installing the
iCR 3600 M is dust and particulates in the environment. The iCR 3600 M is designed to be
resistant to dust and particulates that may be present at the installation site.

2.3 Connectivity and Power Supply

The room needs to have wall power and should not be used with an extension cord. Use
at least a 1300VA (780W) UPS between the wall power and the iCR 3600 M. It is also
required to have a network connection for fast technical support. Alternatively, the user
must have a phone/fax line that can be connected to the PC in order to comply with iCRco
warranty terms.
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2.4 Power Switch Location

The power switch for the CR unit is located on the left hand side of the unit, directly to the
right the fan.

2.5 Power and Scan Lights

The power and scan lights are located on the lower left-hand side
of the CR unit. When the unit is powered on, the green light is
illuminated. While the unit is scanning the yellow light will blink.

2.6 Physical Requirements

The iCR 3600 Mrequires a stable operating environment. It is important the system is
placed on a table, stand or wall mount that provides adequate support.

2.7 System Specifications

Power Requirements

Domestic 100 to 120V, 50/60Hz, 3.5A
International 220 to 240V, 50/60Hz, 1.75A

Temperature Conditions

32 to 105◦F (0 to 40◦C) - operating
0 to 150◦F (-18 to 65◦C) - non-operating

Humidity

15 to 95% non-condensing

Pixels per Line Resolution

4800 (High Resolution) over 240mm
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Scan Rate

Scan Rate 60 lines/second

Grey Scale Resolution

16 bits (65,535 shades of gray)

Interface

USB 2.0

Dimensions

iCR 3600 M 10W x 22H x 44L inches

Vibration/Acceleration

3-4G Max (in shipping)

Altitude

0 to 9,500 ft. - operating

Weight

iCR 3600 M 78 lbs
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3. Hardware Installation

3.1 Unpacking Instructions

1. Open the box from the top.

2. Remove any small accessories loaded into the top of the box.

3. With at least two (2) people, lift the iCR 3600 M out of the box.
! CAUTION Always practice proper heavy lifting procedures. Failure to practice

proper lifting procedures may result in injury or damage to the unit.

4. Store the box and any foam inserts somewhere safe & dry, so that if the iCR 3600 M
needs to be shipped again, there are packing materials available.

3.2 Installing Power Cable

1. Plug the power cable for the iCR 3600 Minto the power switch unit.

2. Plug the other end of the power switch cord into the UPS.

3. Make sure the UPS is not in bypass mode.

4. Plug the UPS into a standard wall outlet.
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3.2.1 International Power Cable

The iCR 3600 Mutilizes an international IEC grade connector for the power cable. Systems
are shipped with a standard NEMA 5-15 hospital grade cable. The cable needs to be
changed depending on the male end, which varies from country to country.

3.3 USB 2.0 Cable Installation

1. Visually inspect the cable to ensure that it is not cut, frayed, or otherwise damaged.

2. Plug the USB B end of the cable end to the CR unit’s USB 2.0 port.

3. Plug the USB A end of the cable end into a free USB 2.0 port on the computer

3.4 Computer Mounting Bracket

1. Attach the Back Computer Mounting bracket to the Computer Mounting Bracket
using four (4) 6-32 x 1

4” flathead screws (Figure 3.1).

Figure 3.1:

2. Align the computer mounting bracket on the back of the cassette tray.

3. Once the screw holes are aligned, fasten the computer mounting bracket to the CR
unit using four (4) 6-32 x 3

8” truss head screws (Figure 3.2).
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Figure 3.2:

4. Carefully slide the computer into the computer mounting bracket (Figure 3.3).
Note For easy access to the CD-ROM drive, make sure the drive opens towards the

outside of the unit.

Figure 3.3:

5. Fasten the computer to the mounting bracket using one (1) 8-32 x 3
8” truss head screws

and #10 flat washer. The computer’s security tab should be in between the washer
and the mounting bracket (Figure 3.4).
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Figure 3.4:

3.5 Wall Mounting Plates

Notice Wall mounting plates must be installed by a licensed contractor.
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1. Attach the large wall mounting plate against wall at desired height. Allow the
contractor to determine the proper screws to fasten the large wall mounting plate to
the wall.

2. Attach the small wall mounting plate to the CR unit with three (3) 6-32 x 3
8” flathead

undercut screws and two (2) 10-32 x 3
4” truss head screws.

! CAUTION Always practice proper heavy lifting procedures. Improper lifting
may cause injury.

3. With at least two people, lift the CR unit onto the large wall mounting plate so that
the bottom of the small wall mounting plate rests in the top notch of the large wall
mounting plate.

4. Secure the bottom of the CR unit to the bottom of the large wall mounting plate with
two (2) 10-32 x 3

4” truss head screws.
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4. Software Installation

4.1 USB Driver Installation

Installation of USB drivers are automatic with the installation of the iCRco software (i.e.,
QPC XSCAN32).

4.2 Installing QPC XSCAN32

QPC XSCAN32 software comes bundled with the CR unit. This software package will
allow the user to interface with the CR unit.

Note If you have QPC XSCAN32 already installed on your computer and it is running
while you are trying to install the new version, an error will appear in the install process.
Please close QPC XSCAN32 and reinstall the new version.

1. Insert the media containing the QPC XSCAN32 installer into the computer. Navigate
to the QPC XSCAN32 folder.

2. Launch the QPC XSCAN32 installer by double clicking Setup.exe.

3. Click Next at the welcome screen.

4. Click Yes to agree to the Software License Agreement.
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5. Make sure both QPC XSCAN32 Software and Software Key Driver boxes are checked,
then click Next.

6. Select Scanning Station or Reading Station depend on the use, then click Next to con-
tinue.

7. Select the appropriate modality, then click Next to continue.

8. Select the appropriate CR hardware profile, then click Next to continue.
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9. The Destination Folder should be set to C:\Xscan32 then click Next to continue.

10. The Program Folder name should be set to QPC XSCAN32, then click Next.

11. QPC XSCAN32 will begin to install. Be patient while XSCAN32 installs.

12. Click Finish to complete the installation of QPC XSCAN32. The installer will exit.
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5. System Operation

5.1 Power-Up

1. Make sure the power cord is properly installed in the power module.

2. Make sure the power cord is properly installed in the UPS and the UPS is plugged
into a standard wall outlet.

3. Make sure the USB 2.0 cord is properly installed in the iCR 3600 M and computer.

4. Power on the computer.

5. Power on the iCR 3600 M by pressing the power switch.

5.2 Cassette Handling

5.2.1 Overview

Unlike other solutions, the iCR 3600 M does not allow for contact to the delicate phosphor
imaging plate. The hard X-ray cassette is designed to protect the plate and allow for it to be
read by the iCR 3600 M. The delicate imaging plate is embedded within a rigid cassette in
such a way that nothing touches the plate during the scanning or handling process.

5.2.2 Weight/Force Applied to Cassette

Apply only minimal weight and/or force to the cassette (for example, do not have a patient
stand on the cassette for weight-bearing views). Use a weight-bearing cap when necessary.

! WARNING Excessive weight/force may damage the cassette and may cause the CR
unit to malfunction. Do not apply excessive weight/force to the cassette.

5.2.3 Cassette Storage

All cassettes should be stored in the cleanest, driest conditions possible. Always store
cassettes in a location where they are not likely to be knocked over or damaged. With
careful handling the cassette plate system should provide years of service as there is no
known lifetime for the phosphors used in the plate system.
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5.2.4 Cassette Contamination

Should the situation arise where a cassette may come in contact with bodily fluids or other
contaminated materials, place the cassette in a clean plastic bag before exposing the X-ray.
This will ensure that the cassette stays clean and usable.

5.3 Cassette Loading

1. Before loading the cassette, orient it properly, with the blue side of the cassette facing
towards the operator with the arrows pointing upwards.

2. Locate the proper sized guide lines on the bezel of the CR unit.

3. At an angle, load the cassette bottom first into the scan bar.
! CAUTION Do not use excessive force when loading the cassette! The cassette will

not fit if the orientation is incorrect.
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4. Gently push the top of the cassette into place.

5. If loaded correctly, the user will see the white guide lines around the edge of the
cassette.

6. Close the bay door.

5.4 Acquiring an Image

! WARNING This equipment employs a laser. Laser radiation may be present if the CR
unit is operated without the covers in place. Avoid the laser beam. Direct eye exposure to
laser light must be avoided.
Note The instructions in this section represent a typical CR workflow. Every workflow

varies in process.
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1. Open the door on the CR unit.

2. Load the cassette into the CR unit. The blue, non-carbon fiber side of the cassette
faces away from the CR unit.
! CAUTION Do not use excessive force when loading the cassette! The cassette will

not fit if the orientation is incorrect. If the user requires more instruction on cassette
loading, please see Section 5.3.

3. Open QPC XSCAN32.

4. Create or edit patient profile. To do this, click New or Edit, respectively.

5. If creating a new patient, enter the relevant patient info, or if editing a patient, change
the information accordingly, then click Save and View.

6. Click on Scan to bring up the Quality Processing Center Scan dialog. (if it is a patient
with no images the scan dialog will automatically appear).

7. The iCR Quality Processing Center dialog will appear.
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8. Select the anatomy by mousing over the skeleton on the left hand side of the Quality
Processing Center dialog.

9. Select the cassette size by clicking the correct button (i.e. 14x17 in, 10x12 in). This
will start the scan.

10. The preview window will display the image as it is scanning. Once it has finished
scanning it will automatically import the image into QPC XSCAN32.

11. Open the scanned image by double clicking on the thumbnail.

12. Rotate/Flip to correct orientation using the Rotate and Flip buttons in the main tool
bar.
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13. Remove any collimation by using the Auto Crop(located in the main toolbar), Mask,
or User Mask (located in the Image Processing dialog) functions.

14. Process using ICE or ICE2 (located in the Image Processing dialog).

15. Window/Level the image using the Window/Level or Smart Box tools.

16. Accept and Save the image to save the processing and W/L settings by clicking the
Save and Accept button in the upper left hand corner of the image.
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17. Return to the Patient Information window. Select the patient(s) to send to a PACS or
viewing station. If you wish to send more than one patient, hold the Ctrl key down
and left mouse click to select multiple patients.

18. After selecting the patient(s), click the DICOM Send button.

19. The DICOM Targets window will appear, choose the desired target, then click OK

20. The results of the DICOM Send will appear in the DICOM Controller window’s Event
log.
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5.5 Schedule of Maintenance

The following is a schedule of maintenance for the iCR 3600 M.

The following maintenance may be performed by end users:

Maintenance Procedure Frequency
Clean cassettes Weekly
Clean iCR 3600 M exterior covers Monthly

The following iCR 3600 M maintenance must be performed by an iCRco authorized service
engineer only:

Maintenance Procedure Frequency
Clean mirrors Yearly
Vacuum inside case Yearly
Clean fan filters Monthly or when visibly dirty.

The following iCR 3600 M calibration maintenance must be performed by an iCRco autho-
rized service engineer only:

Maintenance Procedure Frequency
Check image performance (Contrast/Noise Ratio and Spacial Resolution) Quarterly
Perform Exposure Index calibration Yearly

5.6 Periodic Cleaning

Periodic cleaning of iCRco products should be done on a monthly basis.

5.6.1 Cleaning the Outside of the iCR 3600 M

Note It is important that the covers remain on the iCR 3600 M at all times. The covers
should only be removed for service by an iCRco authorized technician, then immediately
replaced.

! CAUTION Do not clean the galvo mirror. Dust and fibers in the laser beam path may
affect the radiographic image.

The outside covers of the iCR 3600 M should be cleaned with a slightly dampened cloth or
a dry cloth moistened with Ball R©SUNUP R©glass cleaner or Sprayway c©glass cleaner.
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5.6.2 Cassette Cleaning

! CAUTION At no time should abrasive cleaners or chemicals be used to clean the cassette
or plate.

Cleaning the Outside of the Cassette

1. Moisten a clean, lint-free cloth with a mild soap or detergent using soft water.

2. Wipe down the cassette covers thoroughly.

3. Allow the cassette to air dry.

Cleaning the IP Plate

1. With a finger, press the cassette catch located on the bottom rail on the cassette. This
will release the carbon fiber door from the cassette.

2. Examine the imaging plate for dust or particulates.

3. Using iCRco plate cleaner, apply the plate cleaner to a clean, lint-free cloth.
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Note If iCRco Plate Cleaner is not available, please contact Technical Support at
1-310-921-9559 to obtain more.

4. Gently wipe down the imaging plate with the clean, lint-free cloth.

5. Allow the plate to air dry before sliding the carbon fiber door back into place.
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6. QPC XSCAN32 Software Functions

6.1 Creating/Editing Patients

1. Open XSCAN, then click the New button in the Patient Information dialog. Alterna-
tively, if the patient is already in the patient list, select the patient and click the Edit
button on the Patient information dialog.

2. Enter the patient details into the appropriate fields in the dialog box. The user also
needs to enter the exam information for the patient.
Note Last Name, First Name, Date and DOB are required fields. The use can also

make Patient ID a required field by clicking on the Options menu → Preferences →
Defaults tab.

3. Click the Save or Save and View button after the patient details have been entered.

Note The Save and View button will create/edit the patient and open the exam
immediately for viewing or scanning of images.

4. To create an additional exam for the patient, return to the Patient dialog, then click
the New button under Exam. Enter in the exam information.
Note When the user opens an exam with no images QPC XSCAN32 will automat-

ically open the default scan interface. The user can change the the default scan
interface by clicking on Options→ Preferences→ Scanner tab.

6.2 Scan Interface

The scan interface is used to start the scan of the cassette. It is available by clicking the
Scan button in the main toolbar, after opening a patient from the Patient Worklist. The user
may also cancel, rest, and close the scan interface, as well as select the appropriate anatomy,
select High Energy X-ray, enter a barcode, and switch to the Mammography interface (if
enabled).
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1. Shows the currently selected anatomy

2. Shows the current patient name & birth date

3. Close: This button will close the scan interface (it will not close XSCAN)

4. Reset: This button will return the CR unit to the “home” position

5. Cancel: This button will stop the CR unit while scanning. Note that the user will have
to re-expose the cassette, as the image will not be saved.

6. Scanner Settings: various hardware settings for the CR unit (for service use only).

7. Cassette Size Selection: Select the cassette size you are using. When the button is
clicked, the unit will begin to scan.

8. High Energy X-ray: Used to give cassettes a “deep erase.” This will remove any latent
energy from high energy techniques

9. Barcode entry field: Enter the barcode of the cassette here, if using barcodes in your
workflow.

10. Mammography interface button (if enabled): use this button to toggle between the
general and Mammography interfaces.

11. Anatomy selection: mouse over the appropriate anatomy, then select the view from
the pop-up dialog.
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12. Scan preview: once the user has begun the scan, a preview image will appear as the
plate scans.

6.3 Mammography Configuration

Note The Mammography module is an add-on module. It may not be available in every
country. Please contact your sales representative for more information.

1. Before scanning the cassette, switch to the Mammography scanning interface. To do
this, click the iCRco button.

2. Click the Settings button in the Scan interface. Enter the password earl (case sensitive)
when prompted, then click Ok.

3. Make note of the current settings, as they will need to be re-entered when switching
back to general radiography from mammography.
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Notice POTENTIAL LOSS OF DATA! Be sure to take note of the current settings
before entering the new values. The values will be overwritten and there is no way to
recover them. The user will have to manually switch between settings when switching
between general radiography and mammography.

4. Change the following values:
Pixel Rate: 1.4
PMT Voltage 1: 6.5
PMT Voltage 2: 6.5
Laser Power: 24

5. Click the Resolution Settings button.

6. Make sure that the resolution values for 18 x24 cm and 24 x 30 cm cassettes are 50
microns. Click Ok to save the changes.
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7. Click Ok again in the CR Settings window to save the settings.

6.4 Default Mouse Functions for Image Manipulation

Windows / Level Images

The middle mouse button is used to window / level images. Hold down the middle mouse
button (holding the CTRL key and right mouse clicking will also window/level) and move
the mouse vertically to adjust the brightness of the image or move the mouse horizontally
to adjust the contrast of the image.

Magnify (Zooming) Images

The right mouse button is used to magnify images. Hold down the right mouse button and
move the mouse vertically to magnify or reduce the size of the image. (Alternatively the
user can hold down the middle mouse button and move the mouse vertically to magnify.)
To magnify an area of interest in the image, simultaneously hold down the Shift key and
the Left mouse button and move it over the area of interest. Similarly, on a laptop the user
may right click and drag along the touch pad interface to zoom.

Panning Images

Hold down the Left mouse button and move the mouse around the screen. This is useful
when the image is magnified. To pan through the image faster, simultaneously hold down
the Ctrl key and the Left mouse button.
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6.5 Image Processing Dialog Box

Window / Level

Holding the middle mouse button (simultaneously holding the CTRL key and right mouse
clicking will also window/level) down and moving the mouse vertically will adjust the
level and horizontally will adjust the window.

To window and level through more gray values at a time, simultaneously hold down
the Ctrl key and use the Middle Scroll button. This will perform a faster window and level
on images with a large histogram (i.e. CR and DR images). To window and level through
less gray values at a time (i.e., single step through window and level values) simultaneously
hold down the Shift key and use the Middle Scroll button. This will perform a slower
window and level on images with a smaller histogram (i.e., CT and MR images).

Smart Box Window/Level

The Smart Box feature can be activated from the processing toolbar by clicking the icon in
the toolbar. A box enclosed in dashed lines will appear on the image. This is the Smart
Box’s representation of the Auto Window/Function feature.

To resize the smart box hold down the left mouse button on the border of the smart
box and move the mouse forwards and backwards (or up and down if adjusting the bottom
edge).

To resize both edges of the smart box at the same time hold down the Ctrl key and Left
mouse button on any of the four corners of the smart box and move the mouse.

To move the smart box around the image hold down the left mouse button anywhere
inside the smart box and drag the mouse around the image.

The Smart Box’s size and position can be adjusted to yield different results. This allows the
user fast and efficient image processing methods.
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Left and Right CR Markers

1. Open an image for viewing.

2. Select the Left/Right Markers button to apply a Left or Right marker to the image.

3. Select either the Left or Right marker. When the user clicks on the Left/Right Marker
button the Left marker icon will appear. If the user clicks the Left/Right Marker
button again, the Right marker icon will appear. Clicking again will toggle back to
the Left marker.

4. Move the mouse onto the part of the image where the marker needs to appear. When
the user moves the mouse over the image a Left or Right marker icon will appear in
place of the mouse.

5. Click on the image to place the icon.

6. To remove the marker click on the Left/Right Marker button again.

CR Cropping

1. Open the image that needs to be cropped.

2. Select the Crop button from the main toolbar.

3. Hold down the left mouse button to select the region that needs cropping.

4. When the mouse is released, the area to be cropped will be surrounded by a red line.
A message box will appear asking to confirm the selected region.

5. To confirm the region, click Ok.

6. The new image will be created in the same study and will open automatically for
viewing.

Cropping Example:

c©2007-2009
Confidential and Proprietary
Property of iCRco, Inc.

29 of 69 Document # 3600M-01A Rev C
March 22, 2010



iCR 3600 MTM – User Manual

Before After

CR Masking

1. Open an image for viewing.

2. Click the Mask button.

3. To remove the collimation mask, select the Mask button again.

CR Masking Example

Before Masking After Masking

CR User Masking

1. Open an image for viewing.

2. Click the User Mask button.

3. Select the number of views from the Multi-View Mask dialog, (i.e., if there are two hand
exposures on one image, select the two-view button).
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4. Hold the left mouse button down on the start region and move the mouse to the end
of the mask region.

5. Repeat step 4 for each exposure. After the user has completed selecting the number
of exposures, the masks will appear on the image.

6. To remove the User Mask, select the User Mask button.

Moving Icon Thumbnails

1. Open a patient study for viewing.

2. Hold down the Ctrl key while clicking the left mouse button on the image that needs
to be moved. The arrow icon will change to a hand icon . The icon highlighted in
red shows the location where the image will be dropped.

3. To drop the icon, simply release the left mouse button.

Note If the moving icon is highlighted, this
indicates that it will return to its original po-
sition. If an icon is dragged forwards in posi-
tion (i.e. the image number of the highlighted
icon is higher than the moving icon) then all
icons between its original position and its new
position will move backwards and each im-
age number decreases by one. If an icon is
dragged backwards in position (i.e. the image
number of the highlighted icon is less than the
moving icon) then all icons between its orig-
inal position and its new position will move
forward and each image number increases by
one. If no icons are highlighted when drag-
ging, then the image will be returned to its
original position.

c©2007-2009
Confidential and Proprietary
Property of iCRco, Inc.

31 of 69 Document # 3600M-01A Rev C
March 22, 2010



iCR 3600 MTM – User Manual

CR Processing

1. Open an image for viewing.

2. Select an anatomy from the CR Preset box.

3. Click the Process button to begin the processing.

4. The user may press the Reset button to restore the original image data set.
Note the user can also press the Process button again and the original data set will

be automatically restored and processed again.

5. To optimize processing strength, change Gain and Frequency Enhancement as needed.
Note The user can update the CR preset by selecting the Update button, which will

ensure that these processing strengths will be used each time with the currently
selected anatomy.

CR Processing Example:

Original Image Processed Image

About Advanced ICE-2 Processing

ICE-2 is a state-of-the-art image processing package that automatically enhances and
optimizes the diagnostic quality of digital radiographic images. ICE-2 enables the user
more flexibility through the “soft” and “sharp” processing options. The “soft” option
produces an image with less enhancement thereby making the image more “film-like.” The
“sharp” button applies more enhancement to the image.

ICE2 Example: Lateral Lumber Spine

Conventional Processing ICE-2 Processing
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Clicking the drop down menu button located below the “sharp” option gives the user the
ability to refine the image further. After the user clicks on the drop down menu, an interface
appears showing two sliders. The first slider enhances edges and contrast as the slider is
moved to the right. The second slider adjusts image smoothness. Adjust each slider until
the desired result is achieved. Click on the Save As button to save the settings for Soft,
Standard or Sharp processing.

6.6 Annotations

Hide / Show Annotations

Selecting the Hide / Show Annotations button will toggle the visibility of the Annotations
tool pallet.

Annotation Defaults

Used to change the default font name, font size and colors.
Select the Defaults button on the annotations toolbar.

Embed Annotations in Image

Clicking on the Embed Annotations in Image button will save all the annotations into the
image, enabling the user to DICOM send images with annotations. If the annotations are
not embedded, they will not be sent with the image when doing a DICOM send.

Line Annotations

Creates a straight line on the image.

1. Select the Line button from the annotations toolbar.

2. Left mouse click on the area of the image to set the first endpoint.
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3. Move the mouse to where the second endpoint will be.

4. Left mouse click on the are of the image to set the second endpoint.

Extended Line Annotation

Creates a straight line that passes through the image.

1. Select the Extended Line from the annotations toolbar.

2. Left mouse click on the area of the image to set the first endpoint.

Note The line will be extended through the entire image.

3. Move the mouse to where the second endpoint will be.

4. Left mouse click on the area of the image to set the second endpoint.

Arrow Annotation

Creates an arrow on the image, which points to a region of interest.

1. Select the Arrow button from the annotations toolbar.

2. Left mouse click on the area of the image to set the end of the arrow.

3. Move the mouse to where the arrow should point.

4. Left mouse click to set the second endpoint of the arrow head.

Cross Hair Annotation

Creates a cross hair on the image.

1. Select the Cross Hair button from the annotations toolbar.

2. Left mouse click on the area of the image to set the start point of the cross hair.

3. Move the mouse to where the second endpoint will be.

4. Left mouse click on the area of the image to set the cross hair.

Free Hand Annotation

Allows user to draw freehand on the image.

1. Select the Free Hand button from the annotations toolbar.
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2. Hold down the left mouse button on the part of the image that is desired to start
drawing then drag the mouse.

3. Continue to hold the left mouse button and draw as necessary .

4. Release the left mouse button to end the freehand drawing.

Ellipse Annotation

Creates an unfilled ellipse on the image. This feature is used to show a region of interest on
the image.

1. Select the Ellipse button from the annotations toolbar.

2. Left mouse click on the area of the image to start the ellipse.

3. Move the mouse to where the ellipse will end.

4. Left mouse click to set the ellipse in place.

Rectangle Annotation

Creates an unfilled box on the image. Used to show a region of interest on the image.

1. Select the Box button from the annotations toolbar.

2. Left mouse click on the area of the image to start the box.

3. Move the mouse to where the box will end.

4. Left mouse click to set the box in place.

Text Annotation

Creates a text annotation on the image.

1. Select the Text button from the annotations toolbar.

2. Left mouse click on the area of the image to set the upper left corner of the text box.

3. Move the mouse to where the text box will end.

4. Left mouse click to set the size of the text box.

5. The text box will become white with a flashing cursor. Type text.

6. Click anywhere on the image to end the text box.
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Measurement Annotation

Used to measure the distance of a straight line on the image. This can be in inches, cm, mm
and pixels.

1. Select the Measurement button from the annotations toolbar.

2. Left mouse click on the image to set the first endpoint of the measurement.

3. Move the mouse to where the endpoint of the measurement will be.

4. Left mouse click to set the endpoint of the measurement. The measurement will
appear below the line.

5. To place the text in this default position left mouse click on the same point again. To
move the text out of the way, move the mouse to the desired location and left mouse
click to set the placement of the text.

Calibration

The calibration tool compensates for image magnification. It will allow the user to take an
object of known length (a coin, ruler, etc that is not susceptible to measurement distortion),
draw a linear measurement, and assign a length value such that measurements made with
other tools will be accurate in the unit of measurement.

Angle Measurement Annotation

Used to draw an angle on the image.

1. Select the Angle Measurement button on the annotations toolbar.

2. Left mouse click on the image to set the vertex (center point) of the angle.

3. Move the mouse to where the endpoint of the first vector will be.

4. Left mouse click to set the endpoint of the first vector.

5. Move the mouse to where the endpoint of the second vector will be.

6. Left mouse click to set the endpoint of the second vector. The angle measurement
will appear.

7. To place the angle text in this default position left mouse click on the same point
again. To move the angle text out of the way or to change angles, move the mouse to
the desired location and left mouse click to set the placement.
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Cobb Angle Annotation

Used to draw a cobb angle on the image.

1. Select the Cobb Angle button on the annotations toolbar.

2. Left mouse click on the area of the image to set the first endpoint of the first line.

3. Move the mouse to where the second endpoint of the first line will be.

4. Left mouse click on the area of the image to set the second endpoint of the first line.

5. Left mouse click on the area of the image to set the first endpoint of the second line.

6. Move the mouse to where the second endpoint of the second line will be.

7. Left mouse click on the area of the image to set the second endpoint of the second
line. The angle measurement will appear.

8. To place the angle text in this default position left mouse click on the same point
again. To move the angle text out of the way, move the mouse to the desired location
and left mouse click to set the placement.

Heart to Lung Ratio Annotation

Used to find the heart to lung ratio.

1. Select the Heart to Lung Ratio button on the annotations toolbar.

2. Left mouse click on the area of the image to set the first endpoint of the first line.

3. Move the mouse to where the second endpoint of the first line will be.

4. Left mouse click on the area of the image to set the second endpoint of the first line.

5. Left mouse click on the area of the image to set the first endpoint of the second line.

6. Move the mouse to where the second endpoint of the second line will be.

7. Left mouse click on the area of the image to set the second endpoint of the second
line. The ratio measurement will appear.

Center Line Annotation

Used to find the center line of four points.

1. Select the Center Line button on the annotations toolbar.

2. Left mouse click on the area of the image to set the first point.

3. Left mouse click on the area of the image to set the second point
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4. Left mouse click on the area of the image to set the third point.

5. Left mouse click on the area of the image to set the fourth point. The center line of
these four points will be drawn on the image.

Center Point

Used to find the center between two user settable points.

1. Select the Center Point button on the annotations toolbar.

2. Left mouse click on an area to set the first point (it will appear as an X).

3. Left mouse click on an area to set the second point (it will appear as an X).

4. A third, large X will appear in the center of the two other Xs.

Probe

Used to view the X & Y pixel coordinates and the grayscale value for the point.

1. Select the Probe button on the annotations toolbar.

2. Move the mouse to the desired point.

3. Left mouse click and hold, and the X & Y coordinates and gray scale value will be
displayed.

Note While holding down the left mouse button, the user can drag the mouse
pointer and the values will change.

Scale

Used to indicate measures (like increments on a ruler) on the top, bottom, or sides of the
image.

1. Select the Scale button from the annotations toolbar.

2. Set the desired parameters in the dialog box.

3. Click Ok, and the measures will appear on the image.
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Templates

Used to load and draw custom templates.

Select the Templates button on the annotations toolbar.

Measurements Units

Used to toggle between the current measurement units.

Delete All Annotations

Used to permanently remove all annotations from the currently selected images.

Select the Delete All Annotations button.

Deleting Annotations Individually

1. Select the annotation.

2. Right mouse click on the annotation.

3. Select Delete from the pop-up menu.

Selecting Annotations

1. Move the mouse over the annotation. The mouse pointer will become a pointing
hand.

2. Left mouse click on the annotation to select it. The annotation will become a dotted
line with several handles.

Moving Annotations

1. Select the annotation.
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2. Move the mouse over the annotation onto any part of it except the handles (i.e. small
boxes). The icon will change to the moving annotations icon.

3. Left mouse click on the annotations and drag it anywhere on the image.

Resizing Annotations

1. Select the annotation.

2. Move the mouse over the annotation (onto any of the handles). The icon will change
to the resizing annotations icon.

3. Left mouse click on the annotation handle and drag it anywhere on the image.

Note For measurement annotations the size/angle will change accordingly. One of the
handles provided for measurement annotations will also allow the user to reposition the
text.

6.7 Patient CD/DVD Creator

Note CD/DVD Creation Software is NOT part of the QPC XSCAN32 Software. This section
is optional for users who already have CD/DVD Creation Software already installed on
their respective PCs.

1. In the patient information window select the patient(s) to be placed on the CD/DVD.
To select multiple patients hold down your Ctrl key on the keyboard and using your
left mouse button select each patient.

2. Click on the Create CD button in the toolbar. Selected patients will be copied into the
patient CD layout folder (C:\ XscanCDFolder).
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Note If this is the first time using the patient CD creator feature a prompt will appear
indicating the user to browse for the location of the DVD/CD Creator software.
Alternatively, if Nero software is already installed on the PC, select the option Use
Nero scripting to create CD/DVD.

Using Nero Scripting

1. When the software has finished initializing and copying the patient CD, the Nero
scripting dialog will appear.

2. Select the device to burn to. (if multiple drives are present)

3. Put the CD/DVD into the drive and select the Burn button.

4. The drive will eject media once it has completed. Click the Burn button again to make
multiple copies (or alternatively set the Number of copies option before burning).
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Using other CD/DVD recording software

1. When the software has finished initializing and copying the patient CD, a ‘Ready to
create CD’ prompt will appear, select Yes.

2. The DVD/CD Creator software will open. Select source folder C:\ XscanCDFolder
and drag the contents of the Xscan CD Folder folder and two files into the data project
region.

Note The user must not create their own folders on the CD/DVD. The autorun.inf
file must appear in the top level (under the root directory) of the CD/DVD.

3. Click the Record button in CD Creator software.
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6.8 Associating a Barcode with a Study

1. In the patient information window, enter patient and study information.

2. Select patient and study.

3. Select Add Barcode button.

4. Using a barcode reader, scan the barcode of an unexposed cassette.

5. The barcode will be added into the barcode list with the default cassette size 14x17.

6. Repeat steps 3 to 5 for each cassette that will be associated with the study.

Note The user can change the cassette size by clicking under the column Cassette Size and
selecting the actual size. This will be saved for future use in the database.

Note The user can remove the association by selecting the barcode from the list and
selecting the Delete Barcode button.
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6.9 Finding Barcodes and Scanning Images

1. In the patient information window, select the Find Barcode Edit box.

2. Using a barcode reader, scan the barcode of the exposed cassette.

3. Select the anatomy information for the study.
Note This can be corrected later in QPC XSCAN32 when viewing the images.

4. Load cassette into the CR unit.

5. Select the appropriate scan button.

6. QPC XSCAN32 will automatically open the study that the cassette is associated with.
The scan interface will open with the details of the associated patient.

7. The image will be imported into QPC XSCAN32 when it has completed scanning.
The association with that cassette barcode and the study will be removed and the
cassette can be reassigned to another patient.

Other Tips

The scan interface also allows the user to find barcodes in the database. The patient
information displayed in the scan interface will change depending on the barcode selected
for scanning.
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The image below indicates that the image will appear under the patient Joe Smith and the
barcode for the cassette that will be scanned is 01003.

There is an option in the scan interface settings that requires the user to scan the barcode
before they are able to scan cassettes into the interface. In other words they have to tell
the scan interface which barcode they are scanning. If no barcode has been selected for
scanning the user will be prompted to find a barcode.

6.10 Archiving QPC XSCAN32 Database

1. Open XSCAN.

2. Go to File→ Archive Database.

3. The user is asked to confirm the archive process, click Yes.

4. Select the location to archive the database to.
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5. When archiving is completed a message will appear informing the user of the archive
location.
Note the current date and time is used for the folder name of the archived database.

6.11 Restoring Archived Database

! WARNING It is strongly recommended to backing up data to non-spinning media
CD/DVD or an archive (PACS) with RAID capability to ensure no loss of data.

1. To restore an Archive, go to File→ Restore Archive.

Note The current database in QPC must be empty.

2. Select the location of the database to restore.

6.12 Searching QPC XSCAN32 Archive

1. Go to File→ Search Archives.
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2. To search a particular archive, select the archive location by selecting the Browse
button.

3. Under Date/Time, select from the list of valid archives

4. The user can either:

(a) Select Find to open the entire database.

(b) Enter search values into the patient information fields. If the database contains a
patient or multiple patients that match the criteria the database will be opened
with the patient(s) selected. If the patient(s) could not be found you will be
returned to the search dialog. For example, the user could enter “Th” in the First
name field to find values such as “Thomas” and “Thelma.”

5. The user can refine the search further by changing the Match field.
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6.13 Modality Work List Query

6.13.1 Setting-up Modality Work List Query

1. Open QPC XSCAN32, then go to Options→ Preferences→ Image Transfer tab.

2. Check the box for Use DICOM Modality Work List Query.

3. Click the Apply button, then click the Ok button.

4. The QPC XSCAN32 Modality Work List Query window will appear.

Setting-up DICOM Modality Work List Query

Note The EMR/RIS/HIS must support DICOM Modality Work List Query.

1. In the XSCAN32 Modality Work List Query window, click the Options button.

2. Select the radio dialog check box for DICOM Query

Note The User may also set the auto-query options in the Options dialog.

3. Click the Ok button.

4. In the XSCAN32 Modality Work List Query window, click the Select Target button.

5. In the Image Targets window, highlight the desired target, then click the Ok button.

Setting-up Work List HL7 Listen

Note The EMR/RIS/HIS must be able to send HL7 messages. It is not enough just to
general the HL7 message.

1. In the XSCAN32 Modality Work List Query window, click the Options button.

2. Select the radio dialog check box for HL7 Listen.

3. Click the Ok button.

4. An HL7 Listen application will open.

5. Configure the EMR/HIS/RIS to send its HL7 messages to the IP address of the
computer running QPC XSCAN32 on port 6000.

Setting-up Work List Text File Listen

Note The EMR/RIS/HIS must be able to format and send a plain text message.
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Note The Text File Listener should only be used if the EMR/RIS/HIS does not support
DICOM Modality Work List Query or HL7 Messaging.

1. In the XSCAN32 Modality Work List Query window, click the Options button.

2. Select the radio dialog check box for Text File.

3. Instruct your EMR/RIS/HIS vendor to contact iCRco Tech Support to obtain the text
file format.

6.13.2 Using Modality Work List Query

1. To activate the Modality Work List Query interface click on the Work List Query
button in the Patient Information window.

2. The QPC XSCAN32 Modality Work List Query dialog will open. Click on Query
Work List button to query the HIS/RIS system.

(a) Query Work List Button

(b) Search fields. For example, to search for all patients with the last name Smith,
select the Last Name field in the search box and type Smith and then click enter.
Only the patients that have a last name of Smith will appear.

(c) The user can also specify query options such as:

• querying automatically when work list query dialog is opened.

• query on a timer (i.e. every 5 minutes)

• query by modality (i.e. CR patients only)
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• query by AET

• query by Date (i.e. today’s date only)

(d) Click here to select the target to query.
Note The user will only need to do this once.

3. The queried patients will appear in the patient list. Click on Retrieve Selected
Patient(s) button to retrieve the patients into XSCAN32 database.

(a) Retrieve Selected Patient(s) button.

(b) Queried patients appear in the patient list. An envelope indicates a patient that
has not been retrieved. A check mark indicates a patient that has been retrieved.

4. The patients will appear in the QPC XSCAN32 patient information window when
retrieved from the Modality Work List Query dialog.

6.14 Report Writer

1. Open a patient study. Select the desired images to report. The user can have up to
four images on one report (deselect all images if the user does not want to include
any images in the report).

2. Click on the Case button in the toolbar.
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3. Select existing or add a New Facility.

4. Select existing or add a new Findings and Impressions Code. Add patient specific
information to the Findings and Impressions fields.
Note QPC XSCAN32 supports multiple page reports.

5. Select Signature Name for the reading doctors signature.

6. Click on the Image Report button

7. Click the View button to view the report.

(a) Facility field

(b) Signature/Name field

(c) View button

(d) US Color Option. To include color images, select this option.

(e) Image Report button

(f) Patient Specific Findings and Impressions fields

(g) Findings and Impressions Code field

6.15 Long Bone & Scoli Stitching Software

1. Open a patient study for viewing and select the image icons to stitch together.
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2. Click on the Stitch button in the toolbar.
Note This will only appear in the toolbar when the user has installed the stitching

module software.

3. Organize the images in the correct viewing order. Note that no matter what the
users selects for orientation (horizontal or vertical) that the software will only stitch
vertically. For example, if the images appear as they do in Figure 1, then click the
Swap Images button. If the images appear as they do in Figure 2, then rotate the
images to the right 90◦.

Figure 1 Figure 2

4. Select the Start Stitching button when the images are positioned correctly. When
XSCAN finishes stitching, it will display a message box stating that the image is ready
for viewing and the new image will automatically be imported to the study.

Stitching Tips:

1. Images must have at least 1 inch of overlapping data
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CORRECT. INCORRECT.
Overlapping data appears The two edges to be stitched

in both images. should not be collimated.

2. It is important not to collimate on the edges that will be stitched together.
Note The user can collimate on any other edges.

3. Do not move the angle of the anatomy between x-rays. For example, if two images of
an arm are taken on two different cassettes, do not move the angle of the arm for the
second x-ray.

4. Do not change the resolution between x-rays. (All images must be the same scan
resolution.)

6.16 Setting Up DICOM Send

1. Open QPC XSCAN32.

2. Open DICOM Controller V1.00.
Note If the user doesn’t have the window in the task bar open, go to Options →

Preferences→ Image Transfer Tab→ Use DICOM to transfer images.
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3. Click on Targets button and the Image Targets dialog will appear.

6.17 DICOM Send

1. Open a patient study for viewing and select the image icons to send.

2. Click on the DICOM Send button in the toolbar.
Note This will only appear in the toolbar when the Use DICOM to transfer images

option is selected in the Image Transfer preferences tab.

3. The Image Targets dialog will appear. Select the target(s) to send the selected images
to.

4. Select OK to confirm the selected target(s).
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5. The status of the send will appear in the Event Log of the DICOM Controller window.
Note If sending to another XSCAN32 application the user can turn compression on

and select a compression type (low, medium, high).

6.18 DICOM Retrieve

1. Open QPC XSCAN32

2. Click on the DICOM Retrieve button in the toolbar.
Note This will only appear in the toolbar when the user has the Use DICOM to

transfer images option selected in the Image Transfer preferences tab.

3. The Image Targets dialog will appear. Select the target to retrieve images from.

4. Select OK to confirm the selected target.

5. If the user has selected the Search Parameters option, then enter any relevant patient
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or study information. For example, to search on all patients with the name John
Smith, type John Smith into the Patient Name field. To search on all patients with
the last name Smith, type *Smith* into the Patient Name field. Where the asterisk * is
used as a wildcard. To search on Study ID 12345, type 12345 into the Study ID field or
1234* to bring up all study ID’s starting with 1234.
Note It is not necessary to fill out all fields. For a description of the valid wildcards

click on the Wildcards button.

6. The list of matching patients will be returned.

7. Select the patient(s) to retrieve from the list and click on the Retrieve button.

6.19 DICOM Auto-Send

6.19.1 Setting-up DICOM Auto-Send

1. Open QPC XSCAN32.
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2. Go to Options→ Preferences→ Image Transfer tab.

3. Select the option Auto send scanned images.

Figure 6.1: Check the Auto send box to enable auto-send

4. Set the Send delay. The default is one (1) minute.

5. Click the Select Target(s) button.

6. Select the target(s) to send to. The User may Ctrl-click to select multiple targets.

Figure 6.2: Select the Target(s) to auto-send to.

7. Click the Apply button, then the Ok button.

6.19.2 Using DICOM Auto-Send

1. Open an image for viewing.

2. Process and optimize the image as necessary.

3. Click the Accept button to accept and auto-send the image to the target. If the image
is reprocessed or the orientation changed, the Accept button will reappear, and the
image can be resent if necessary.
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6.20 DICOM Store and Forward Utility

Setting up targets for forwarding

1. Under the All Targets list, select the target(s) to forward.

2. Click the Add� button.

3. To remove target(s) from the forward to list, select the target under the Forward To list,
then click the� Remove button.

Configuring Store and Forward Utility DICOM settings

1. Click the Configure button.

2. The default DICOM settings are:

• AET SF DICOM

• Port: 4009

Sending to Store and Forward Utility

1. From the sending application, select the images to send.

2. Then select the Store and Forward Utility as the DICOM target to send to ( the AET of
SF DICOM). The images will appear in the Scheduler Event Log.

3. The Store and Forward Utility will keep retrying to send images if failed.

4. The status will be updated with sending, complete or transfer pending.
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Options

The Store and Forward Utility defaults to receiving compressed images and forwarding
them on decompressed. If you want to receive compressed images and send them on
compressed to the PACS system, then deselect the option Receive compressed image, forward
uncompressed.

Note The Store and Forward Utility may report the status as complete but the PACS system
may still reject the image. If the image has an incorrect DICOM tag or it is a duplicate study,
series or image UID. Always confirm that the PACS system has received the image before
deleting images from the capture station.

6.21 HL7 Configuration

1. Open QPC XSCAN32.

2. In the Patient Information window, click Worklist Query button to open the Modality
Worklist Query window.

3. In the Modality Worklist Query windows, click Options.

4. In the Options dialog box, check the radio dialog button for HL7 Listen.

5. Check the radio dialog boxes for Mark retrieved patients and Automatically Query
target when opened.
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Note The user may also check the radio dialog box for Automatically Query target
every x minutes, and set the time interval for the worklist query.

6. Click Ok. A new window will open called HL7 DICOM Worklist Parser Port: 6000.

7. In the HL7 DICOM Worklist Parser window, ensure that the port is 6000. If it is not,
click on File→ Set Port In new window, change port to 6000, then click Ok.

8. In the HL7 DICOM Worklist Parser File menu, make sure there is a check next to
Listen. If there is not, click on Listen in the File menu to enable parser listening.

9. Make sure that in System→ HL7 Message Defaults, that all boxes are checked.

10. Leave window open and let the parser retrieve HL7 messages. When an HL7 message
is received, the window will have parsed text in it. Multiple messages can be received
while window is open.

11. Click the Query button to get message information (If messages are not automatically
queried).

12. Highlight messages that you want to retrieve and click Retrieve.

6.22 Advanced DICOM Printer

Select images for printing

In QPC XSCAN32, select the images to
print in the image icon view, then select
DICOM Print from the toolbar. The Ad-
vanced DICOM Printer application will
open with the selected images imported
into the right hand side. Alternatively,
the user can select the region in the pre-
view window where the user wants the
image, then select the Import Image but-
ton.

Drag and Drop Images

To drag images into the print region hold the left mouse button down on one of the image
icons on the right hand side and drag it into the preview window. A dragging cursor will

appear as the user drags the image from the image icon window to the preview window.

If the user is out of the accepted region for dropping, a cursor will appear letting the
user know that this is not a correct region to drop the image into.
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Split the preview window into regions

To split the preview window the user needs to first select the region to split. For example, if
there are currently no divisions in the preview window then click anywhere in the preview
window and a green line will appear around the window. This will enable the image

division buttons. Alternatively, the user can press Shift+ right mouse click
inside the preview window region to split it. A pop-up menu will appear with these
division buttons (as the image to the right shows).

Select one of the image division buttons and the preview window will be divided into
regions. To split one of these regions again select the specified region and again select one
of the image division buttons. The user can drag and drop images at any stage. If the user
has an image in the region that is desired, the interface will automatically move the image
into the split regions. To remove a division, click in the region that has been split and click

on the no-division button.
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The user can show and hide the image divisions by clicking on the Page Layout tab, then
click Show and Lock under Image Divisions. The user can view the current print settings
by looking at the left hand side of the Advanced DICOM Printer dialog. To change these
settings, or to view more settings, click on the Printers tab.

Manipulating Images in the Preview Window

The Advanced DICOM Printer allows the user to
flip, rotate, zoom, pan, invert and window/level
images. To manipulate the images select the im-
age in the preview window (the selection will
be shown by the green box surrounding the im-
age).

The user can flip, rotate and invert by using the but-
tons on the left hand side of the DICOM Printer dia-
log.

The user can zoom by using the right mouse button
on the selected image.

To pan the image use the left mouse button on the selected image.
Note The user can only pan the image when it is zoomed in. To window/level the user

can either use the middle scroll button on the mouse or type the required window/level
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into the edit boxes on the left hand side of the Advanced DICOM Printer dialog. Then press
the Update button to change the window/level for the image.

The user can also press the 1:1 button to tell the Advanced DICOM Printer dialog to print
images at 1:1 resolution.

The user can use the Orientation button to change from landscape to portrait view.

Change margins

The margin tab permits the user to specify, in English or metric units, the size of the borders
on the printed image. The top and bottom borders on the page can be adjusted indepen-
dently of the borders for the left and the right hand side of the page.

Additionally, the user has the option to control the internal
margins, which define the amount of space left between in-
dividual frames on a page with multiple images. Internal
margins are defined as multiples of the print page border
size.

By default, internal margins are the same size as the bor-
ders, with image margins on, the left and right hand side
of each frame are equal to the left and right hand bor-
ders. Margins on the top and bottom of each frame
are equal to the top and bottom borders of the printed
page.

If the user intends to cut individual frames out of the printed
page, it is recommended that internal margins are set to twice
that of the page, which will give a uniform border size on the individual image segments.
If it is necessary to maximize the amount of space on the printed page, the internal margins
can be turned off altogether.

Saving and Loading Print Layout

The Templates tab allows the user to save and load pre-defined print layouts. There are five
user defined layouts. Set up the layout on the preview window and then select one of the
buttons labeled Click here to save current layout! The user will be prompted for a title.

To save more layouts click on the Save Current Template button. here the user can set a
file name for the Layout. The default save location is C : \XScan32\Layout\Custom.
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Adding patient demographics

Select the Overlay tab to bring up the patient demographic layout options.
From here the user can select:

• Text position (includes top left, top center, top right, bottom left, bottom center, bottom
right),

• Text size (includes: small, medium, large),

• Text color (includes: white on black, black on white).

The user has the option to apply the current settings to every image in the print view or
only in the currently selected image via the Apply to all images button or the Apply to
image button.

By selecting the Enable Overlay check box the user can turn patient demographics overlay
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on and off for all images. The user can also edit the fields that are available on patient
demographics overlay by clicking on the Edit Fields button.
From here the user is able to:

• Select a field and determine what kind of a delimiter following the field (includes:
none, space, tab, comma, newline, custom).

• Change the position of the fields with the up and down arrows.

• Remove or display a field by selecting the Print Field check.

• Print the title for the field (i.e. the title “Date:” would be printed in front of the date
field).

After editing the fields select the Done button.

Print preview

To see a print preview, select the Print Preview button.

Print an image from DICOM Printer

When the user has finished dragging and dropping the desired images onto the preview
window and manipulating size, position and window/level (if necessary), then press the
Print button in the bottom left hand corner of the DICOM Printer dialog. Please ensure all
the printer settings are correct first.
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Patient Demographics for Icons

When the cursor is over the icon bank, Advanced DICOM Print will display the demo-
graphics for the image.

Multiple Icon Pages

Advanced DICOM Print has an unlimited number of icons that can be loaded. However,
the PC’s memory is a restriction.

To clear the current page of icons, click on Clear Current Page button. To clear all the
pages of icons and preview window, click on Clear All Pages button.

To move between pages and move to first and last pages click on the arrow buttons.

6.23 Printing to a Windows Printer

1. To configure XSCAN to open the DICOM Application Print Server, go to Options→Preferences→Image
Transfer tab. Select the option Use Windows to DICOM Printer. DICOM Print must also
be selected.
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2. The Dicom Application Print Server will print to the default windows printer. In the
Windows Control Panel select “Set As Default Printer” to the desired printer. The print
server uses this default printer.

3. To change the AET, port number or any other information for the DICOM Application
Print Server, click on the Settings button.

4. To print to the DICOM Application Print Server, set the AET in the Advanced DICOM
Printer to the DICOM Application Print Server’s AET details.

5. Select the images in QPC XSCAN32 to print and then select the DICOM Print button.
Optimize the images in the QPC XSCAN32 software and select print.

6.23.1 Troubleshooting Windows to DICOM Print

1. Make sure there is only one instance of them open in Task Manager. To open Task
Manager (Click on Start Menu, Click Run, Type in “taskmgr” Click OK). Close QPC
XSCAN32. Look for DCM.exe, DICOMMultiPrinter.exe, AppPrintSCP.exe. If any of
these are open please select and click on End Process. Reopen QPC XSCAN32.
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2. Check target information for both applications (Advanced DICOM Print and DICOM
Application Printer Server). Select Advanced DICOM Print and click on Configure
DICOM button. The DICOM Configuration dialog will appear. The target details for
this application are usually: AET: ADV PRINT DICOM, PORT: 4008, IP: 127.0.0.1,
Click on Select to see full details of this target. If Advanced DICOM Print has not
been entered as an item in the targets list then please add it with the above details.
Then select this new target and click OK. Click OK on the DICOM Configuration to
save settings. Close QPC XSCAN32 and reopen Select DICOM Application Printer
Server and click on Settings button. The DICOM Configuration dialog will appear.
The target details for this application are usually: AET: PRINT DICOM, PORT: 3008,
IP: 127.0.0.1, Click on Select to see full details of this target. If DICOM Application
Printer Server has not been entered as an item in the targets list then please add it with
the above details. Then select this new target and click OK. Close QPC XSCAN32
and reopen. Go to Advanced DICOM Print and Test Printer, assuming that you
have the DICOM PRINT target selected as the default printer to print to. To set
it as the default, select the Printer tab in ADVANCED DICOM PRINT and select
DICOM PRINT button. Try printing. If fails recheck that multiple instances are not
open in task manager.

3. Make sure no options are selected that should not be selected. If the printer does not
support border properties then deselect. If the printer does not support background
properties then deselect. If the printer does not support 12-bit images then deselect.
Try printing. If fails recheck that multiple instances are not open in task manager.

4. Make sure correct print options are selected. If printing to a windows printer you
cannot have BLUE FILM selected (unless it has BLUE FILM). You need to select
PAPER. The default for a regular windows printer for paper size is 8Inx12IN. Try
other options if this fails. If you have the wrong paper size selected it will bring up a
failed message in DICOM Application Printer Server and the message log will say
incorrect paper size.

6.24 QPC XSCAN32 Keyboard Shortcuts

Function Keys

F1 Rotates an image clockwise.
F2 Rotates an image counter-clockwise.
F3 Horizontally flips an image.
F4 Vertically flips an image.
F5 Inverts an image.
F7 Opens and closes the Window/Level dialog.
F8 Opens and closes the CR Processing dialog.
F9 Resets the window/level of an image to the original window/level setting.
Shift + F8 Opens and closes the Annotations dialog.
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Ctrl + F8 Turns the patient information overlay on and off.
F11 Opens QPC XScan32 Help.
F12 Selects and deselects all image icons.
Ctrl + A Selects and deselects all image icons.
Ctrl + D Deletes the selected image icons.
Shift + P Opens preferences.
Shift + S Adds images to the send queue.
Ctrl + S Sends queued images.
Shift + Q Adds images to the send queue and sends the queued images.
Shift + R Imports received images immediately.
Right Arrow Moves to the next image.
Left Arrow Moves to the previous image.
Down Arrow Moves to the next row of images.
Up Arrow Moves to the previous row of images.
Page Down Moves to the next page.
Page Up Moves to the previous page.
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